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Legal Information
INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH INTEL PRODUCTS. NO LICENSE,
EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS
GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN INTEL'S TERMS AND CONDITIONS OF SALE FOR
SUCH PRODUCTS, INTEL ASSUMES NO LIABILITY WHATSOEVER AND INTEL DISCLAIMS ANY EXPRESS OR
IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF INTEL PRODUCTS INCLUDING LIABILITY OR
WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR INFRINGEMENT
OF ANY PATENT, COPYRIGHT OR OTHER INTELLECTUAL PROPERTY RIGHT.

A "Mission Critical Application" is any application in which failure of the Intel Product could result, directly or
indirectly, in personal injury or death. SHOULD YOU PURCHASE OR USE INTEL'S PRODUCTS FOR ANY SUCH
MISSION CRITICAL APPLICATION, YOU SHALL INDEMNIFY AND HOLD INTEL AND ITS SUBSIDIARIES,
SUBCONTRACTORS AND AFFILIATES, AND THE DIRECTORS, OFFICERS, AND EMPLOYEES OF EACH,
HARMLESS AGAINST ALL CLAIMS COSTS, DAMAGES, AND EXPENSES AND REASONABLE ATTORNEYS' FEES
ARISING OUT OF, DIRECTLY OR INDIRECTLY, ANY CLAIM OF PRODUCT LIABILITY, PERSONAL INJURY, OR
DEATH ARISING IN ANY WAY OUT OF SUCH MISSION CRITICAL APPLICATION, WHETHER OR NOT INTEL OR
ITS SUBCONTRACTOR WAS NEGLIGENT IN THE DESIGN, MANUFACTURE, OR WARNING OF THE INTEL
PRODUCT OR ANY OF ITS PARTS.

Intel may make changes to specifications and product descriptions at any time, without notice. Designers
must not rely on the absence or characteristics of any features or instructions marked "reserved" or
"undefined". Intel reserves these for future definition and shall have no responsibility whatsoever for conflicts
or incompatibilities arising from future changes to them. The information here is subject to change without
notice. Do not finalize a design with this information.

The products described in this document may contain design defects or errors known as errata which may
cause the product to deviate from published specifications. Current characterized errata are available on
request. Contact your local Intel sales office or your distributor to obtain the latest specifications and before
placing your product order. Copies of documents which have an order number and are referenced in this
document, or other Intel literature, may be obtained by calling 1-800-548-4725, or go to: http://
www.intel.com/design/literature.htm

Intel processor numbers are not a measure of performance. Processor numbers differentiate features within
each processor family, not across different processor families. Go to: http://www.intel.com/products/
processor_number/

BlueMoon, BunnyPeople, Celeron, Celeron Inside, Centrino, Centrino Inside, Cilk, Core Inside, E-GOLD,
Flexpipe, i960, Intel, the Intel logo, Intel AppUp, Intel Atom, Intel Atom Inside, Intel CoFluent, Intel Core,
Intel Inside, Intel Insider, the Intel Inside logo, Intel NetBurst, Intel NetMerge, Intel NetStructure, Intel
SingleDriver, Intel SpeedStep, Intel Sponsors of Tomorrow., the Intel Sponsors of Tomorrow. logo, Intel
StrataFlash, Intel vPro, Intel Xeon Phi, Intel XScale, InTru, the InTru logo, the InTru Inside logo, InTru
soundmark, Itanium, Itanium Inside, MCS, MMX, Pentium, Pentium Inside, Puma, skoool, the skoool logo,
SMARTi, Sound Mark, Stay With It, The Creators Project, The Journey Inside, Thunderbolt, Ultrabook, vPro
Inside, VTune, Xeon, Xeon Inside, X-GOLD, XMM, X-PMU and XPOSYS are trademarks of Intel Corporation in
the U.S. and/or other countries.

*Other names and brands may be claimed as the property of others.

Copyright © 2009-2012, Intel Corporation. All rights reserved.
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Overview

 Discover how to find and fix memory errors using the Intel® Inspector XE and the nqueens_fortran
Fortran sample application.

About This
Tutorial

This tutorial demonstrates an end-to-end workflow you can ultimately apply to your
own applications:

1. Build an application to produce an optimal inspection result.
2. Inspect an application to find memory errors.
3. Edit application code to fix the memory errors.
4. Investigate memory errors using interactive debugging.
5. Rebuild and reinspect the application.

Estimated
Duration

10-15 minutes.

Learning
Objectives

After you complete this tutorial, you should be able to:

• List the steps to find and fix memory errors using the Intel Inspector XE.
• Define key Intel Inspector XE terms.
• Identify compiler/linker options that produce the most accurate and complete

analysis results.
• Run memory error analyses.
• Influence analysis scope and running time.
• Navigate among windows in the Intel Inspector XE results.
• Display a prioritized to-do list for fixing errors.
• Access help for fixing specific errors.
• Access source code to fix errors.
• Launch an interactive debugging session to investigate problems more deeply.

More Resources The concepts and procedures in this tutorial apply regardless of programming
language; however, a similar tutorial using a sample application in another
programming language may be available at http://software.intel.com/en-us/articles/
intel-software-product-tutorials/. This site also offers tutorials for other Intel®
products and a printable version (PDF) of tutorials.

In addition, you can find more resources at http://software.intel.com/en-us/articles/
intel-parallel-studio-xe/.
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Navigation Quick Start 1
 Intel® Inspector XE is a dynamic memory and threading error checking tool for users developing serial

and multithreaded applications on Windows* and Linux* operating systems. You can also use the Intel
Inspector XE to visualize and manage static analysis results created by Intel® compilers in various suite
products.

Intel Inspector XE Access
1. Do one of the following:

• Type one of the following source commands to set up your environment:

• source <install-dir>/inspxe-vars.sh
• source <install-dir>/inspxe-vars.csh

• Add <install-dir>/bin32 or <install-dir>/bin64 to your path.

NOTE The default installation directory is /opt/intel/inspector_xe_2013/.

2. Type inspxe-gui.

Intel Inspector XE GUI
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 - 
The menu, toolbar, and Project Navigator offer different ways to perform many of
the same functions.

Use the menu to create projects and dynamic analysis results, import
result archive files and results from other Intel® error-detection products,
open projects and results, compare results, configure projects, set
various options, and access the Getting Started page and Help.

Use the toolbar to open the Getting Started page; create, configure, and
open projects; create dynamic analysis results; and open and compare
results.

Use the Project Navigator:

• Tree to see a hierarchical view of your projects and results based on
the directory where the opened project resides.

• Context menus (right-click to open) to perform functions available
from the menu and toolbar plus delete or rename a selected project or
result, close all opened results, and copy various directory paths to the
system clipboard.

Use result tabs to view and manage result data.

Intel Inspector XE Result Tabs

Use result tab names to distinguish among results.

 1   Getting Started Tutorial: Analyzing Memory Errors
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Click buttons on the navigation toolbar to change window views.

Use window panes to view and manage result data.

Click  buttons to display help pages that describe how to use window panes.

Drag window pane borders to resize window panes.

Click , , , and  controls to show/hide window panes.

Click window pane data controls to adjust result data within the pane (and possibly in adjacent
panes).

Data column headers - Drag to reposition the data column; drag the left or right border to
resize the data column; click to sort results in ascending or descending order by column data.

Use title bars to identify window panes.

Right-click data in window panes to display context menus that provide access to key
capabilities.

Navigation Quick Start  1 
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Analyzing Memory Errors 2
 There are many ways to take advantage of the power and flexibility of the Intel Inspector XE. The

following workflow, which shows how to find and fix memory errors in serial or parallel programs, is one way
to help maximize your productivity as quickly as possible.

Step 1: Unpack
and set up
sample for
analysis

Build an application to inspect for memory errors and create a new project.

Step 2: Collect
result

• Configure a memory error analysis.
• Run the memory error analysis on the application.

Step 3:
Investigate
result

• Choose a problem set in the analysis result.
• Interpret the result data.
• Resolve the issue.
• Investigate another problem using interactive debugging.

Step 4: Check
your work

Rebuild the application and rerun the memory error analysis.

Build Application and Create New Project

 To create an application the Intel Inspector XE can inspect for memory errors:
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• Get software tools.
• Verify optimal compiler/linker settings.
• Build the application.
• Verify the application runs outside the Intel Inspector XE.
• Open the Intel Inspector XE GUI.
• Create a new project.

Get Software Tools
You need the following tools to try tutorial steps yourself using the nqueens_fortran sample application:

• Intel Inspector XE installation package (.tgz file and license information)
• .tgz file extraction utility
• Supported compiler (see Release Notes for more information)
• Editor

Acquire the Intel Inspector XE

If you do not already have access to the Intel Inspector XE, you can download an evaluation copy from
http://software.intel.com/en-us/articles/intel-software-evaluation-center/.

Install and Set Up the Intel Inspector XE Sample Applications

1. Copy the nqueens_fortran.tgz file from the <install-dir>/samples/<locale>/Fortran/
directory to a writable directory or share on your system. The default <install-dir> is /opt/intel/
inspector_xe_2013/.

2. Extract the sample from the .tgz file to create the nqueens_fortran directory.
3. Ensure you have set the EDITOR or VISUAL environment variable to your text editor.

• Samples are non-deterministic. Your screens may vary from the screen captures shown throughout
this tutorial.

• Samples are designed only to illustrate the Intel Inspector XE features; they do not represent best
practices for creating code.

Verify Optimal Compiler/Linker Settings
You can use the Intel® Inspector XE on both debug and release modes of C++ and Fortran binaries
containing native code; however, applications compiled/linked in debug mode using the following settings
produce the most accurate and complete analysis results.

Compiler/Linker
Property

Correct C/C++
Setting

Correct Fortran
Setting

Impact If Not Set
Correctly

Debug information Enabled (-g) Enabled (-debug or -g) Missing file/line
information

Optimization Disabled (-O0) Disabled (-O0) Incorrect file/line
information

Dynamic runtime library Selected (-shared-
intel for Intel(R)
compilers; default or -
Bdynamic for GNU
compilers)

Selected (-shared-
intel)

False positives or
missing code locations

 2   Getting Started Tutorial: Analyzing Memory Errors
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Compiler/Linker
Property

Correct C/C++
Setting

Correct Fortran
Setting

Impact If Not Set
Correctly

Basic runtime error
checks

Disabled (do not use -
fmudflap)

None (-check:none) False positives

Build the Application

1. In a terminal session, change directory to the nqueens_fortran/ directory.
2. Type make nqueens_memory_debug to build a debug version of the nqueens_memory sample

application.

Verify the Application Runs Outside the Intel Inspector XE

1. In the same terminal session, type ./nqueens_memory_debug to execute the sample application.
2. Check for non-deterministic application output similar to the following:

Usages: nqueens_memory[_debug] boardSize
Using default size of 10
Starting nqueens solver for size 10 with 8 thread(s)
Number of solutions: 724
correct result!
Calculations took 116 ms.

Open the Intel Inspector XE GUI

1. In another terminal session, do one of the following:

• Type one of the following source commands to set up your environment:

• source <install-dir>/inspxe-vars.sh
• source <install-dir>/inspxe-vars.csh

• Add <install-dir>/bin32 or <install-dir>/bin64 to your path.

NOTE The default installation directory is /opt/intel/inspector_xe_2013/.

2. Type inspxe-gui.

Create a New Project

1. Choose File > New > Project... to display a dialog box similar to the following:
 

 

Analyzing Memory Errors  2 
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2. In the Project name field, type memory_issues. Then click the Create project button to create a
config.inspxeproj file in the ~/intel/inspxe/projects/memory_issues/ directory (default
location) and display a dialog box similar to the following:
 

 
3. Click the Browse... button next to the Application field and select the nqueens_fortran/

nqueens_memory_debug application. Notice the Intel Inspector XE autofills the project Working
directory field for you. Then click the OK button to return to the Welcome page, where the name of
the opened project displays in the title bar and in the Project Navigator pane. (If necessary, choose
View > Project Navigator to display the Project Navigator.)

Key Terms
False positive

Configure Analysis

 Intel Inspector XE offers a range of preset memory analysis types to help you control analysis scope
and cost. The analysis type with the narrowest scope minimizes the load on the system and the time and
resources required to perform the analysis; however, it detects the narrowest set of errors and provides

 2   Getting Started Tutorial: Analyzing Memory Errors
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minimal details. The analysis type with the widest scope maximizes the load on the system and the time and
resources required to perform the analysis; however, it detects the widest set of errors and provides context
and the maximum amount of detail for those errors.

To configure a memory error analysis, choose a memory analysis type.

Choose a Memory Error Analysis Type
To display an Analysis Type window similar to the following: Choose File > New > Analysis...

 

 

Use the Navigation toolbar to navigate among the Intel Inspector XE windows. The buttons on
the toolbar vary depending on the displayed window.

Use the Analysis Type drop-down list to choose an analysis type category: Memory Error
Analysis, Threading Error Analysis, or Custom Analysis Types.

Choose the Memory Error Analysis type category.

Analyzing Memory Errors  2 

17



NOTE This tutorial covers memory error analysis types, which you can use to search for
resource leak, incorrect memcpy call, invalid deallocation, invalid memory access, invalid
partial memory access, memory growth, memory leak, memory not deallocated,
mismatched allocation/deallocation, missing allocation, uninitialized memory access, and
uninitialized partial memory access errors. Use threading error analysis types to search
for data race, deadlock, lock hierarchy violation, and cross-thread stack access errors.

Use the configuration slider to choose a preset analysis type and the corresponding gauges to
assess the cost of that choice. The preset analysis type at the top of the slider has the
narrowest scope; the preset analysis type at the bottom has the widest.

Choose the Detect Memory Problems preset analysis type.

The Analysis Time Overhead gauge helps you quickly estimate the time it may take to collect
a result using this preset analysis type. Time is expressed in relation to normal application
execution time. For example, 2x - 20x is 2 to 20 times longer than normal application execution
time. If normal application execution time is 5 seconds, estimated collection time is 10 to 100
seconds.

The Memory Overhead gauge helps you quickly estimate the memory the Intel Inspector XE
may consume to detect errors using this preset analysis type. Memory is expressed in blue-
filled bars.

NOTE The gauge does not show memory used by the running application during analysis.

Use the checkbox(es), radio button(s), and drop-down list(s) to fine-tune some, but not all,
preset analysis type settings.

NOTE If you need to fine-tune more analysis type settings, you can choose another
analysis type or create a custom analysis type.

Use the Details region to view all current settings for this analysis type.

Use the Command toolbar to control analysis runs and perform other functions. For example,
use the Project Properties button to display the Project Properties dialog box, where you
can change the default result directory location, set parameters to potentially speed up
analysis, and perform other project configuration functions.

If you experimented with various settings, make sure you choose the Detect Memory Problems preset
analysis type (and ensure your settings match the image above) before proceeding.

Key Terms
Analysis

Run Analysis

 To find memory errors that may need fixing, run a memory error analysis.
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Run Memory Error Analysis
Click the Start button on the Analysis Type window and the Intel Inspector XE:

• Executes the nqueens_memory_debug application.
• Identifies memory errors that may need handling.
• Collects the result in a directory in the intel/inspxe/projects/memory_issues/ directory.
• Finalizes the result.

During analysis, the Intel Inspector XE displays a Collection Log window similar to the following: 
 

 

The result name appears in the tab. Here, the name of the result is r000mi2, where

• r = constant
• 000 = next available number
• mi = memory error analysis type
• 2 = preset analysis type of medium scope

NOTE Intel Inspector XE also offers a pointer to the result in the Project Navigator.

The Collection Log pane shows analysis progress and milestones.

Analyzing Memory Errors  2 
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Notice you can start to manage results before analysis (collection and finalization) is complete
by clicking the Summary button; however, this tutorial does not cover handling issues before
analysis is complete.

NOTE This tutorial explains how to run an analysis from the Intel Inspector XE GUI. You can also use
the Intel Inspector XE command-line interface (inspxe-cl command) to run an analysis.

The Summary window automatically displays after analysis completes successfully.

Key Terms
• Analysis
• Collection
• Finalization

Choose Problem

 To start exploring a detected memory error:
• Understand Summary window panes.
• Choose a problem.
Understand Summary Window Panes
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The Summary window is the starting point for managing result data. It groups problems into
problem sets and then prioritizes the problem sets by severity and size.

Think of the Problems pane as a to-do list. Start at the top and work your way down. Try
viewing the problems in various problem sets by clicking the corresponding  icon.

The Code Locations pane shows the code location summary, surrounding source code snippet,
call stack, and thread and timeline information for all code locations in one or all occurrences of
the problem(s) highlighted in the Problems pane.

Choose a Problem
When you are finished experimenting, double-click the data row for the Memory leak problem set to display
the Sources window, which provides more visibility into the cause of the error.

Key Terms

• Code location
• Problem
• Problem set
• Result

Interpret Result Data

 To determine the cause of the detected memory error:

• Interpret Sources window pane tabs.
• Access more information on interpreting and resolving problems.

Interpret Sources Window Pane Tabs
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The Source tab shows the complete source surrounding one code location in the Memory leak
problem: Allocation site.

The Allocation site code location represents the location from which the memory block was
allocated. Notice the source code corresponding to the Allocation site code location is
highlighted.

The Disassembly tab shows low-level operations for the Allocation site code location in the
Memory leak problem.

The Call Stack tab shows the complete call stack for the Allocation site code location in the
Memory leak problem.

Use the /  icons to expand/collapse source, disassembly, and call stack information for each
code location region in a problem.

Access More Information on Interpreting and Resolving Problems

1. Right-click anywhere in the Source or Disassembly tab.
2. Choose Explain Problem to display the Intel Inspector XE Help information for the Memory leak

problem type.

Key Terms

• Code location
• Problem
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Resolve Issue

 To fix the detected memory error:

• Investigate the issue.
• Access an editor directly from the Intel Inspector XE.
• Change the source code.

Investigate the Issue
Scroll to near line 94. The embedded commenting in the nqueens_memory.f90 sample file reveals the cause
of the Memory leak error: The deallocate call near line 95 that releases the memory is commented out.

Access an Editor
Double-click near line 94 in the Source tab to open the nqueens_memory.f90 source file in an editor:
 

 

Change the Source Code

1. Uncomment !deallocate (correct_solution).
2. Save your edits.
3. Click the result tab to return to the Sources window.

NOTE The Sources window data is unchanged because it is a snapshot of the source code at the time
of analysis.

4. Click the Summary button to display the Summary window.

Analyzing Memory Errors  2 
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Key Terms
Code location

Investigate Problem Using Interactive Debugging

 Investigate a problem more deeply with an interactive debugging session during analysis.

• Launch an interactive debugging session.
• Display extended debugging commands.
• Stop the analysis and interactive debugging session.

Launch an Interactive Debugging Session
In the Problems pane on the Summary window, right-click the data row for the Uninitialized memory
access problem set to display a context menu, then choose Debug this problem to:

• Launch a new analysis, r001mi2, with the same configuration settings used to create the r000mi2
result, except the analysis is optimized to detect only the Uninitialized memory access problem.

• Halt application execution and open a debugging session when the Intel Inspector XE detects the first
occurrence of the Uninitialized memory access problem.

The debugger displays problem breakpoint information in a prob-brk-id: prob_brk_desc format, where:

• prob-brk-id is a debugger-assigned integer value that identifies the problem breakpoint.
• prob-brk-desc is a short problem description.

NOTE Do not confuse the prob-brk-id values assigned by the debugger with problem IDs prefaced
with the letter P in the Intel Inspector XE result data.

 2   Getting Started Tutorial: Analyzing Memory Errors

24



Display Extended Debugging Commands
During the interactive debugging session, use the normal debugger actions to examine memory and other
state information, set code breakpoints, and continue execution. Only the use of data breakpoints is not
supported.

Intel Inspector XE also offers a set of command extensions to use within an interactive debugging session
during analysis. Type monitor help to view a list applicable to memory error analyses:
 

 

Stop the Analysis and Interactive Debugging Session
When you are finished experimenting in the debugger workspace, stop both the interactive debugging
session and the analysis:

1. Return to the Intel Inspector XE window. Notice the new, still-running, r001mi2 result.
2. Click the Stop button on the Intel Inspector XE Command toolbar.

When finalization is complete, the Intel Inspector XE displays a Summary window for the new r001mi2
result that contains only the Uninitialized memory access problem.

TIP Intel Inspector XE automatically adjusts the debugging session analysis to return to the
Uninitialized memory access problem more quickly; however the analysis adjustments do not
correspond to individual problem types. Consequently, the Intel Inspector XE may detect and report
additional problems, but it will break only for the Uninitialized memory access problem.

Key Terms

• Problem
• Problem breakpoint
• Problem set

Analyzing Memory Errors  2 
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Rebuild and Rerun Analysis

 To check if your edits resolved the Memory leak problem:

• Rebuild the application with your edited source code.
• Rerun the analysis.

Rebuild the Application
In another terminal session, type make nqueens_memory_debug in the nqueens_fortran/ directory.

Rerun the Analysis
To run another analysis of the same analysis type: In the Intel Inspector XE GUI, choose File > New >
Memory Error Analysis / Detect Memory Problems.

The Summary window automatically displays after analysis (both collection and finalization) completes
successfully:

Notice the Intel Inspector XE:

• Created a new result tab: r002mi2.
• No longer detects the Memory leak problem.

Key Terms
Analysis
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Summary 3
 This tutorial demonstrated an end-to-end workflow you can ultimately apply to your own applications.

Step Tutorial Recap Key Tutorial Take-aways

1. Set up You built and ensured the
application runs on your system
outside the Intel Inspector XE, and
created a project to hold analysis
results.

Applications compiled and linked in debug
mode using the following options produce the
most accurate and complete analysis results:
-debug, -O0, -shared-intel, and -
check:none.

2. Collect result You chose an analysis type and ran
an analysis. During analysis, the
Intel Inspector XE:

• Ran the application, identified
errors that may need handling,
collected a result, and displayed
the result in a result tab.

• Added a pointer to the result in
the Project Navigator.

• Intel Inspector XE offers preset analysis
types to help you control analysis scope
and cost. Widening analysis scope
maximizes the load on the system, and the
time and resources required to perform the
analysis.

• Run error analyses from the File menu,
toolbar, or command line using the
inspxe-cl command.

3. Investigate
result

You explored detected problems,
interpreted the result data,
accessed an editor directly from
the Intel Inspector XE, and
changed source code. You also
investigated a problem using
interactive debugging.

• Key terms: A code location is a fact the
Intel Inspector XE observes at a source
code location. A problem is one or more
occurrences of a detected issue. A problem
set is a group of problems with a common
problem type and a shared code location
that might share a common solution.

• Think of the Problems pane on the
Summary window as a to-do list: Start at
the top and work your way down.

• Double-click a code location or problem on
the Summary window to navigate to the
Sources window. Click the Summary
button on the Sources window to return
to the Summary window.

• Right-click various places on the
Summary or Sources window to display a
context menu, then choose Explain
Problem to access more information on
interpreting and resolving the problem.

• Double-click a code location on the
Sources window to open an editor.

• Right-click a problem, then choose Debug
This Problem to launch an interactive
debugging session.

4. Check your
work

You recompiled, relinked, and
reinspected the application.
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Next step: Prepare your own application(s) for analysis. Then use the Intel Inspector XE to find and fix
errors.
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Key Terms 4
 The following terms are used throughout this tutorial.

analysis: A process during which the Intel Inspector XE performs collection and finalization.

code location: A fact the Intel Inspector XE observes at a source code location, such as a write code
location. Previously called an observation.

collection: A process during which the Intel Inspector XE executes an application, identifies issues that may
need handling, and collects those issues in a result.

false positive: A reported error that is not an error.

finalization: A process during which the Intel Inspector XE uses debug information from binary files to
convert symbol information into filenames and line numbers, performs duplicate elimination (if requested),
and forms problem sets.

problem: One or more occurrences of a detected issue, such as an uninitialized memory access. Multiple
occurrences have the same call stack but a different thread or timestamp. You can view information for a
problem as well as for each occurrence.

problem breakpoint: A breakpoint that halts execution when a memory or threading analysis detects a
problem. In a Linux* debugger, a problem breakpoint is indicated by display of source line information, a
unique problem breakpoint ID, and a short problem description.

problem set: A group of problems with a common problem type and a shared code location that might
share a common solution, such as a problem set resulting from deallocating an object too early during
program execution. You can view problem sets only after analysis is complete.

project: A compiled application; a collection of configurable attributes, including suppression rules and
search directories; and a container for analysis results.

result: A collection of issues that may need handling.

target: An application the Intel Inspector XE inspects for errors.
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